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Chapitre 1: Notions de Topographie, Topométrie et Géodésie  

 

1. Historique  

On peut retrouver des indices de travaux topographiques jusqu’à la plus haute antiquité 

(travaux hydrauliques, construction de grands édifices) et manifestement la définition de la 

propriété foncière était déjà source de conflits en Égypte ancienne ou en Mésopotamie. 

Cependant, le grand essor des techniques topographiques date du XVIIème siècle. La mesure 

des formes de la Terre se rattache aux travaux de l’Académie des Sciences. En effet, Abbé 

Picard, dès 1660, a su développer des instruments de visée extrêmement précis. Ensuite, 

Bouguer, La Condamine, Clairaut, Huyghens, etc., puis les quatre générations de la famille 

Cassini qui ont fait des progrès absolument décisifs à la géodésie et à la cartographie. Il faut 

en retenir qu’entre 1760 et 1950, la précision des méthodes topométriques n’a même pas 

gagné un facteur 10, les seuls progrès significatifs étant dans le domaine de la facilité de mise 

en œuvre et dans l’ergonomie de ces techniques. 

Aujourd’hui, la notion de réseau géodésique national s’efface de plus en plus avec un 

positionnement spatial mondial précis et d’accès facile comme les techniques GPS, et la 

notion de carte de base, document de base commun à tous types d’activités localisées et 

permettant la synergie entre travaux ultérieurs, disparaît devant le besoin omniprésent de 

bases de données numériques nationales ou mondiales, réclamées pour les applications des 

systèmes d’informations géographiques, et dont les performances semblent devoir disqualifier 

tout autre moyen de représentation de la surface topographique.  

2. Définitions 

2.1. Géodésie 

La Géodésie a pour objet initial l’étude et la mesure de la forme générale de la Terre, de sa 

rotation, de son champ de pesanteur et des différents systèmes de référence employables pour 

se repérer. Par extension de langage, le géodésien est celui qui fournit des points d’appui 

connus par leurs coordonnées pour les travaux topographiques dont l’objet est ainsi de 

densifier considérablement ce canevas de référence. 

2.2. Topographie 

La topographie a pour objet la description et la représentation locale des formes de la surface 

de la Terre. Le topographe procède donc à des levés, soit en mesurant directement sur le 

terrain (mesures d’angles, de distances, ou GPS), soit en exploitant les propriétés métriques 

d’images aériennes stéréoscopiques du sol (photogrammétrie). 
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2.3. Topométrie 

La topométrie représente l’ensemble des moyens géométriques employés pour effectuer des 

mesures de positions relatives de points. C’est donc la boîte à outils de base du topographe.  

Le travail du géomètre recouvre une série d’activités complémentaires mais étendues, allant 

de la topographie sous toutes ses formes à la cartographie (art qui consiste à représenter au 

mieux la topographie sous forme de cartes), et à tous les aspects techniques et juridiques de la 

définition de la propriété foncière. 

Nota : en Topographie, Topométrie et Géodésie, les angles sont exprimés en degrés ou en 

grades et les pressions en millimètres de mercure. On rappelle les correspondances avec les 

unités légales : 

1°= π/180 rad ; 

1 gr = π/200 rad ; 

1 mmHg = 133 Pa. 

3. Formes et dimensions de la Terre 

3.1. Géoïde  

Dans un langage courant, la Terre est considérée ayant une forme d’une sphère. Cependant, 

elle est légèrement déformée par la force centrifuge induite par sa rotation autour de l’axe des 

pôles, vu qu'elle n’est pas un corps rigide. Cette déformation est relativement faible : 

«tassement» de 11 km au niveau des pôles par rapport à un rayon moyen de 6 367 km et 

«renflement» de 11 km au niveau de l’équateur. Elle a donc l’aspect d’un ellipsoïde de 

révolution dont le petit axe est l’axe de rotation, appelé l’axe des pôles (Figure 1). 

 

Figure 1: Ellipsoïde et Géoïde (LAPOINTE et MEYER, 1986) 

La Terre est une surface en équilibre. La surface du niveau moyen des mers et océans au 

repos n’a pourtant pas une forme régulière et ne coïncide ainsi pas avec un ellipsoïde de 

révolution : elle n’est pas régulière mais ondulée, présente des creux et des bosses (Figure 1.). 

Par exemple, la surface de la mer se bombe au-dessus d’un volcan et se creuse au-dessus des 

grandes fosses océaniques parce que les reliefs créent des excès ou des déficits de matière 
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produisant ainsi des variations locales du champ de pesanteur. Or, la surface d’un fluide en 

équilibre est en tout point normale aux forces de pesanteur : on dit qu’elle est équipotentielle 

du champ de pesanteur. La Terre, non rigide, peut être considérée comme un fluide ; la 

direction des forces de pesanteur varie d’un endroit à un autre en raison de la répartition 

hétérogène de la matière composant la Terre ; sa surface n’est donc pas régulière. 

La surface des mers et océans au repos recouvrant toute la Terre est appelée Géoïde (Figure1)  

Le géoïde, niveau des mers prolongé sous les continents, est donc une surface gauche à 

laquelle on ne saurait appliquer des relations mathématiques de transformation. Il est la 

surface de référence pour la détermination des altitudes, autrement dit la surface de niveau 

zéro. En réalité, la référence en altitude dépend du choix du repère fondamental et du système 

d’altitude. Il s’ensuit que la surface de niveau zéro est légèrement différente du géoïde ; 

l’écart est constant et représente l’altitude du point fondamental au-dessus du géoïde. 

4. Repérage d'une position sur la surface de la Terre  

Afin de repérer une position sur la surface de la terre, on peut utiliser deux systèmes: 

 Le système cartésien qui dépend de l'origine de la sphère. Cependant, ce système est 

peu pratique et est utilisable uniquement dans le cas où on dispose de données 

précises.  

 Le système de référence géographique basé sur la valeur de longitude et de la latitude. 

Ce système dépend de l'origine et de la forme de la sphère ou de l'ellipsoïde utilisé, 

d'où l'existence de plusieurs systèmes de références. Ainsi, quand on reçoit ou on 

donne des coordonnées (longitudes-latitudes), il faut préciser le système de référence 

par rapport auquel elles ont été déterminées.  

 

         

a. Système cartésien                                                             b.    Système géographique 

Figure 2 : Les systèmes de repérage des coordonnées (https://www.metis.upmc.fr/LPRO-

RQEE/sites/default/files/cours-L3-SIG-eljanyani%20%5BMode%20de%20compatibilit%C3%A9%5D.pdf).  
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Chapitre 2 : Situation Géodésique de l’Algérie 

Introduction  

Le réseau géodésique Algérien a connu plusieurs phases d'évolution qui peuvent se résumé en 

Trois (03) phases principales: 

- Le réseau géodésique classique  

- Le réseau géodésique Doppler 

- Le réseau de points GPS 

1. Le réseau géodésique classique 

Le réseau géodésique classique a été réparti en deux zones, à savoir: la zone du parallèle nord 

et la zone Saharienne. 

1.1. La géodésie du parallèle Nord du 1er ordre 

Le parallèle nord également nommé la chaîne du parallèle nord Algérie couvre la zone 

comprise entre les chaines primordiales et la mer méditerranéenne et s'étale des frontières 

avec le Maroc jusqu'aux frontières avec la Tunisie. Cette opération comprend deux 

ensembles : La chaîne primordiale et le 1er ordre complémentaire. 

 La chaîne primordiale 

Cette opération a été entamée en 1953 et venait compléter l'ancienne chaîne. Ainsi, l'ancienne 

chaîne qui comprenait 80 points a été renforcée par l'ajout de 100 nouveaux points. Les 

observations ont été réalisées en utilisant le Théodolite Wild T3. 

 Le 1er ordre complémentaire 

Cette opération comprend 30 nouveaux points géodésiques venant renforcés les 25 points 

préexistants. Ces points sont répartis en 03 blocs comme suit:  

- Bloc de Mostaganem à Cherchell sur environ 190 Kms: 08 anciens points restationnés et 08 

nouveaux points. 

- Bloc de Cap Matifou à Béjaia sur environ 200Kms: 09 anciens points restationnés et 11 

nouveaux points. 

- Bloc de Béjaia à Annaba sur environ 220 Kms: 08 anciens points restationnés et 10 

nouveaux points. 

Les observations ont été exécutées en utilisant le Théodolite Wild T3.  

 



Université des Sciences et de la Technologie Houari Boumediene (USTHB)  
Cours de SIG                                                                                          

Dr. DJERBAL Lynda – Maitre de Conférences « B » 
Page 5 

 

 

Nota: Le parallèle nord comprend 450 points distants de 30 à 45 cm. La précision en 

planimétrie de ces points varie entre 10 et 15 cm et la précision relative moyenne est de 

l'ordre de 6 cm. 

 

1.2. Le réseau Géodésique de 1er ordre densifié par un réseau de 2ème ordre  

Le réseau du 1er ordre  a été densifié par un réseau composé de 3291 points géodésiques 

(Figure 2) régulièrement répartis et matérialisés sur la partie nord de l'Algérie (parallèle nord). 

Ces points sont distants de 10 à 20 m et présentent une précision relative moyenne de l'ordre 

de 12cm.  Les observations ont été réalisées en utilisant le Théodolite Wild T3.  

1.3. Le réseau Saharien 

Ce réseau est composé de deux sous-ensembles: le réseau astronomique et l'Axe 3000.  

 Le réseau astronomique 

Cette opération a été réalisée entre 1954 et 1968. Elle comprend au total 636 points 

déterminés au Théodolite Wild T3 (Figure 1). La précision absolue de ce réseau, déterminé 

sur l'ellipsoïde de Clarke 1880, est d'environ 30m.  

 

Figure 1: Le réseau astronomique (INCT, 2007) 

 L'Axe 3000 

Entre 1954 et 1962, une observation, ayant pour objectif le développement économique et 

stratégique de la région du Sahara, a conduit à la réalisation d'une opération géodésique 

nommée "l'Axe 3000". Cette opération comprend (Figure 4):  
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- Une grande chaîne diagonale de 1600 Kms reliant Abadla (près de Béchar) à Djanet 

rattachée par cheminement.  

- Un cheminement méridien de 700 Kms joignant Amguid et Ourgla. 

- La triangulation de In Bebel et le rattachement de Tabelbala.  

 

Figure 2 : Le réseau géodésique du parallèle Nord (réseau du 1er ordre) 

« http://www.inct.mdn.dz/web_inct_sim/act-geodesie.php » 

 

2. Le réseau géodésique Doppler 

Cette technique utilise le Radar Doppler. Un Radar Doppler est un radar qui utilise l'effet 

Doppler-Fizeau de l'écho réfléchi par une cible pour mesurer sa vitesse radiale. Le 

signal micro-onde — émis par l'antenne directionnelle du radar — est réfléchi par la cible et 

comparé en fréquence avec le signal original allé et retour. Il permet ainsi une mesure directe 

et extrêmement précise de la composante vitesse de la cible dans l'axe du faisceau. Les radars 

Doppler sont utilisés pour la défense aérienne, pour le contrôle du trafic aérien, pour la 

surveillance des satellites, pour les contrôles de vitesse sur route, en radiologie et dans 

les réseaux d'assainissement. 

Le réseau de points Doppler a été réalisé par l'INCT entre 1980 et 1990. Il est composé de 122 

points d'une précision relative de 10 à 15m (Figure 3). Ce réseau a été renforcé par 8 points du 

réseau ADOS (African DOppler Survey) d'une précision moyenne relative de 1m. 
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Figure 3 : Le réseau géodésique DOPLER (http://www.inct.mdn.dz/web_inct_sim/act-

geodesie.php). 

3. Le réseau géodésique GPS 

Le réseau GPS a été réalisé en deux parties (Figure 4) : 

3.1. Le réseau GPS d'ordre Zéro 

L'opération a été réalisée entre 1998 et 2005. Elle comprend 20 points d'une précision 

moyenne planimétrique de 5mm et altimétrique de 1cm. 

3.2. Le réseau de densification GPS 

Il consiste à la détermination d'un ensemble de points de grande précision appartenant au 

réseau de géodésie classique par GPS. Ces points ont servi à unifier les deux systèmes de 

projection (WGS84 et Nord Sahara) en déterminant les paramètres de passage les plus précis 

que possible. Ce réseau compte 1290 points espacés de 20 à 30 Kms. La précision relative de 

ce réseau planimétrie est de l'ordre de 2cm et en altimétrique de 5cm. 
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Figure 4 : Le réseau GPS « http://www.inct.mdn.dz/web_inct_sim/act-geodesie.php » 

3. Les systèmes de projection utilisés en Algérie 

Pour les besoins cartographiques, on est contraint de représenter l’image de la terre sur une 

surface plane assimilée à un ellipsoïde donné. Les coordonnées planes obtenues permettent 

d’effectuer des mesures directes sur la carte. 

Les cartes de l’Algérie sont réalisées selon différents systèmes de projection en fonction de la 

période durant laquelle elles ont été établies. On distingue quatre systèmes de projection 

principaux selon lesquels sont réalisées les cartes en Algérie. 

3.1. Le Lambert Algérie  

Ce système est divisé en deux zones : Lambert Nord Algérie et Lambert Sud Algérie. Il s’agit 

de la projection de l'ellipsoïde (modèle mathématique de la terre) sur un cône dont le sommet 

est sur l'axe des pôles et ce cône est tangent au parallèle origine de latitude phi0 ou parallèle 

central. Cependant, la projection conique Lambert a été abandonnée vers le début des années 

80. 

3.2. Le système Nord Sahara 1959 

Le système géodésique Nord-Sahara 1959 a été utilisé pour le canevas de base des cartes 

d'Algérie des régions sahariennes au 1: 200 000. Ce système est le seul en vigueur pour des 

latitudes inférieures à 32° Nord. Il est exprimé dans l'un des fuseaux de la projection UTM sur 
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l'ellipsoïde de Clarke 1880 Anglais. La situation du sud de la région saharienne est cependant 

un peu plus complexe. Nord-Sahara 1959 a remplacé Voirol 1875 en 1960 (arrêté au J.O. du 

14 janvier 1960) et a été notamment défini pour les travaux devant servir d'appui à la 

cartographie des territoires du Sahara. Ce système a permis de concilier les canevas de 

triangulation avec les canevas astronomiques. Les cartes des régions du sud du Sahara sont 

dressées uniquement à partir d'un réseau astronomique. 

3.3. Le système UTM Algérie 

La projection cylindrique UTM (Universal Transverse Mercator) couvre le monde entier et est 

constituée de 60 fuseaux de 6 degrés d’amplitude en longitude. Cette projection est réalisée 

selon l’ellipsoïde de Clarke 1880. La Base de données applicable pour l’Algérie présente 

quatre fuseaux (Figure 5) :  

UTM zone 29N entre 12° et 6° Ouest,  

UTM zone 30N entre 6° Ouest et 0° Greenwich,  

UTM zone 31N entre 0° Greenwich et 6° Est, 

UTM zone 32N entre 6° et 12° Est. 

 

Figure 5 : Aperçue de la position de l’Algérie selon la projection UTM. 

 

3.4. Le système WGS84 

WGS 84 (World Geodetic System 1984) est un système mondial mis au point par le 
département de la défense des États-Unis et utilisé par le GPS, basé sur l’éllipsoïde WGS84. 
Ce système utilise une projection cylindrique. 
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Chapitre 3 : Notions Fondamentales sur les Systèmes d'Information 

Géographiques (SIG) 

 

 Qu’est-ce qu’une INFORMATION GEOGRAPHIQUE ? 

Elle désigne toutes informations sur des entités localisées sur la surface de la terre (végitation, 

pentes, personnes, ouvrages, infrastructures,…). L’information géographique comporte deux 

composantes : une composante graphique et une composante attributaire. 

a. La composante graphique 

Elle comporte la description de la forme de l’objet géographique ainsi que sa localisation dans 

un référentiel cartographique (un système de projection donné). 

b. La composante attributaire 

Elle comporte des caractéristiques décrivant l’objet (description géométrique, caractéristiques 

thématiques,…).  

1. Enjeu de la représentation de l’information géographique 

L’information géographique était couramment représentée sous forme de cartes (carte de 

végétations, carte d’état-major, carte des routes, Plan d’occupation des sols,…). Cependant, 

cette représentation présente beaucoup d’inconvénients :  

- On a généralement besoin dans la pratique de deux composantes (graphique et 

attributaire) : pour la représentation de la composante graphique cela fonctionne bien. 

Or, la représentation des informations attributaires est très limitée.  

- Elle nécessite l’utilisation de beaucoup de papier. 

- Les cartes sont à des échelles différentes. 

- Difficulté de mettre les cartes à jour. 

- Dégradation des cartes. 

- Insuffisance des cartes pour la gestion des informations. 

- La carte donne une représentation de l’information à un instant « t » donné. Elles sont 

donc souvent obsolètes et périmées. 

- L’information géographique est issue de différentes sources de données (levé de 

terrain, photos aérienne, images satellite, données web, GPS,…) qui ne peuvent pas 

être prisent en charge simultanément par une carte muette. 

- Difficulté de superposition et de croisement des informations existantes sur les cartes. 

Les systèmes d’information géographiques (SIG), qui consistent à associer à un objet 

graphique des informations géographiques et attributaires moyennant un système 

informatique, ont ainsi été développés pour palier à ces insuffisances. 
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2. Définition d’un système d’information géographique (SIG) 

Un système d’information géographique (SIG) est un moyen de gestion de base de données 

conçu pour saisir, stocker, manipuler, analyser, combiner et afficher des données à référence 

spatiale en vue de résoudre des problèmes complexes de gestion et de planification 

(FISCHER et al., 1993). Les SIG sont des outils d’aide à la décision, ils permettent une 

meilleure gestion des aléas naturels (tels que les mouvements de terrain, les inondations, les 

séismes, …) et des risques technologiques (feux de forêts, explosions,…). Le SIG inclut 

plusieurs composantes (voir la figure 1). Ces systèmes possèdent plusieurs avantages : 

- Le stockage sous forme numérique de gros volumes de données géographiques de 

manière centralisée et durable ; 

- La gestion des données à référence spatiale qui sont associées à des objets ou à des 

phénomènes qui se caractérisent par une position (à titre d’exemple : les coordonnées 

géographiques) et très souvent par une forme géométrique (polygones, polylignes, lignes, 

point) (SERRE, 2005) ;  

- Il a la capacité d’accepter et de convertir des données sous des formes 

géométriques (SERRE, 2005) ; 

- Il permet la gestion des formes géométriques entre elles selon leur aspect géométrique 

grâce à des fonctions topologiques (la topologie est un sous-ensemble de la géométrie qui 

se réfère aux relations spatiales existant entre les entités géographiques) (SERRE, 2005) ; 

- Il permet d’actualiser ou de modifier les données sans avoir à créer un nouveau système 

d’information géographique. 

Tous les auteurs s’accordent sur la puissance des SIG et donc sur leur excellence en tant 

qu’outils de gestion des données à référence spatiale. La caractéristique fondamentale qui 

distingue les SIG des logiciels graphiques, notamment de la cartographie numérique, est leur 

capacité d’effectuer des analyses spatiales (LAARIBI, 2000). Cependant, les fonctionnalités 

incorporées au sein du SIG répondent généralement aux besoins immédiats qui sont beaucoup 

plus axés sur la gestion des données que sur leur analyse (BURROUGH, 1990 ; FISCHER et 

al., 1993).  

En outre, les SIG ont bénéficié des progrès réalisés indépendamment dans deux branches 

importantes de l’informatique : d’une part la conception assistée par ordinateur (CAO) et le 

dessin assisté par ordinateur (DAO), dont dérive la cartographie assistée par ordinateur ; 

d’autre part les systèmes de gestion de bases de données (SGBD) (HAMMOUM H. et al., 

2010).   
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Figure 1 : Composantes d’un SIG (FISCHER et al., 1993).   

3. Quel est le rôle d’un SIG ? 

Un SIG permet de gérer (archivage structuré) des données modéliser la réalité (abstraction), 
produire de l’information (manipulation, échange, publication), localiser des entités et analyse 
d’un territoire, etc. En d’autres termes, un SIG est défini comme « Ensemble de données 

repérées dans l’espace, structuré de façon à pouvoir en extraire commodément des 

synthèses utiles à la décision ainsi que des cartographies rapides ».  Il est constitué de 5 
composants principaux :  

 Données : Il constitue le composant principal du SIG. Il s’agit d’informations 

localisées géographiquement (graphiques ou attributaires) 

 Matériel : Informatique (ordinateurs), terrain, outils pour acquisition et traitement de 

l’information. 

 Utilisateurs qualifiés 

 Territoires : Outils d’aide à la discision pour la problématique traitée. 

 Logiciel : Une interface informatique permettant l’automatisation de l’information. 

En outre, un SIG permet l’organisation des données géographiques en respect avec leurs types 

sous forme de couches ou de thèmes d’informations superposables.  

Exemple : On peut superposer différents types d’informations, tel que : les courbes de niveau, 

les réseaux vitaux, les routes, les viaducs, les réseaux hydrographiques,… nécessaires à une 

prise de décision. 
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4. Structure des données sous SIG 

La construction d’un système d’Information Géographique nécessite, comme le montre la 

Figure 2, deux composants principaux : des données localisée sur le territoire sous format 

graphique (sous forme de cartes, données vectorielles) et des données alphanumériques 

(attributaires) organisées sous un système d’information (sous Excel par exemple)  

 

Figure 2 : Les composants d’un SIG 

4.1.Les données graphiques 

La représentation des données se fait sous deux formats : 

- Format de vecteur (Points, Lignes, Polygones) 

Ce type de représentation, également appelée image vectorielle ou couche vectorielle, est une 

image numérique composée d’objets géométriques de type : segment de droite, polygones, 

polylignes, arc de cercle, point, etc. Ce type de données peut comporter des données 

attributaires individuelles pour chaque élément. 
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Exemple :  

 

 

 

- Les données Raster 

Il s’agit d’images matricielles ou images en mode points. C’est une image numérique 

composée de Pixels ou de points généralement de forme rectangulaire ou plane. On distingue 

plusieurs types d’images Raster : Image satellite, photographies, image ou carte scannée. 

Un pixel : Le pixel (souvent abrégé px) est l'unité de base permettant de mesurer la définition 

d'une image numérique matricielle. Son nom provient de la locution anglaise picture element, 

qui signifie « élément d'image ». À chaque pixel est associée une couleur, usuellement 

décomposée en trois composantes primaires par synthèse additive : rouge - vert - bleu. En 

variant l'intensité de chacun de ces points, on peut afficher des milliers de couleurs différentes 

(Figure 3). 

 

Figure 3 : exemple d’image Pixélisée (extrait de la carte topographique d’Alger) 

- Comparaison entre le mode Raster et le mode vecteur  

Les deux types de représentation des données sous un SIG (Raster et vecteur) sont 

complémentaires. Le mode raster est mieux adapté aux applications de télédétection et pour 

certaines études où l’utilisation des données raster ne nécessite pas un traitement de données 

attributaires ou constitue uniquement fond pour les réseaux numérisés dessus pour une 

meilleure prise de décision. Cependant, la représentation en mode vecteur est nécessaire pour 

la réalisation de calculs essentiels à la prise de décision (statistique, spatial, logiques, 

thématique,…) 

Les villes Le réseau routier Les Ilots 
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Tableau 1 : comparaison entre le mode Raster et le mode vecteur 

(https://www.metis.upmc.fr/LPRO-RQEE/sites/default/files/cours-L3-SIG-

eljanyani%20%5BMode%20de%20compatibilit%C3%A9%5D.pdf) 

 

Par ailleurs, il est possible de convertir une table vectorielle en table raster ou une table raster 

en table vectorielle. Cependant, le passage du mode vecteur au mode raster est facile tandis 

que le passage du mode raster au mode vecteur nécessite des cartes de bonne résolution 

(Figure 4). 

 

Figure 4 : Image montrant le passage du mode Raster en mode Vecteur 

(https://www.metis.upmc.fr/LPRO-RQEE/sites/default/files/cours-L3-SIG-

eljanyani%20%5BMode%20de%20compatibilit%C3%A9%5D.pdf). 

4.2.Les données attributaires  
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Il s’agit de données alphanumériques récupérées sous format numérique (Excel, Texte,…) ou 

papier (un tableau de coordonnées topographique, un rapport d’étude,…).  Ces données sont 

par la suite organisées sous un format numérique (système d’information) pouvant être lu par 

le logiciel de SIG utilisé. 

          

 

Figure 5 : Exemple de données attributaires. 

5. Étapes de construction et sorties d’un SIG 

Pour construire un système d’information « SIG » fiable, Il est nécessaire de suivre un 

cheminement dit « la méthode des (05 A) ». Cette méthode consiste à suivre 05 étapes pour la 

réalisation du SIG, il s’agit : 

• Acquisition des données (raster, lever topo, essais,…) 

• Abstraction (dépouille) des données : Il s’agit de l’étape la plus difficile et la plus 

importante lors de laquelle les données sont traitées par des spécialistes afin d’éliminer 

certaines données floues ou illogiques. 

• Archivage des données (base de données, couches vectorielles) 

• Affichage des données  

• Analyse des données (répondre aux questions liées au problème traité) 

L’affichage et l’analyse des données, également appelé sorties du SIG, peuvent être de 

différentes natures. Les sorties obtenus par l’application d’un SIG constituent des réponses à 

des questions posées par l’utilisateur afin d’analyser une problématique (gestion du réseau 

routier, gestion de l’alimentation en eau potable, gestion des secours,…) et de produire des 

documents nécessaires à la prise de décision. La figure 6 montre les types principaux de 

sorties qu’on peut obtenir avec un SIG. 

a. Levé topographique 
b. Données sur le réseau 

routier 



Université des Sciences et de la Technologie Houari Boumediene (USTHB)  
Cours de SIG                                                                                          

Dr. DJERBAL Lynda – Maitre de Conférences « B » 
Page 17 

 

 

 

Figure 6 : Les sorties d’un SIG 

6. Les domaines d’application des SIG 

Vu que les SIG présentent de nombreux avantages pour le stockage des informations de façon 

claire et durable, gestion et affichage d’une multiplicité d'informations attributaires sur des 

objets, établissement des cartographies rapides, localisation des données dans l'espace et dans 

le temps, réaction rapide après des évènements ayant un impact sur le territoire (actualiser les 

cartes et les attributs, établir de nouvelles cartes), ils sont actuellement utilisés dans plusieurs 

domaines tels que : l’urbanisme, le tourisme, le commerce, les travaux publique, la géologie, 

la géotechnique, la biologie, le transport, etc.  

Par ailleurs, Le SIG constitue un outil d’aide à la décision pour le décideur. Ainsi, il doit 

permettre la réalisation de documents cartographiques de qualité prendre les meilleures 

décisions. C’est SIG sont alors utilisé pour produire des cartes en grande et petite échelle. 

Pour les grandes échelles 

- La gestion foncière et cadastrale (recensement des propriétés, calcul de surfaces) 

- La planification urbaine (plan d’occupation des sols et d’aménagement) 

- La gestion des transports (voies de circulations, signalisation routière) 

- La gestion des réseaux (assainissement, AEP, gaz, électricité, téléphone ...) 

- La gestion du patrimoine (espaces verts, parcs, jardins ...) 

- Les applications topographiques (travaux publics et génie civil) 
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Pour les échelles moyennes et petites 

- Les études d’impact (implantation d’un centre commercial ou d’une école) 

- Les études d’ingénierie routière (constructions de routes ou d’autoroutes) 

- Les applications liées à la sécurité civile (prévention des risques naturels et technologiques). 

- La gestion des ressources naturelles (protection de l’environnement, études géologiques, 

climatologiques ou hydrographiques). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

LES TRAVAUX PRATIQUES 
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TP01 : Installation et Présentation du logiciel MapInfo 

 

L’objectif de ce TP est de montrer aux étudiants la procédure d’installation du logiciel 

MapInfo et de leur présenter l’interface du logiciel. Ainsi, nous allons effectuer un survol des 

menus et des commandes du logiciel. Par ailleurs, cette  partie ne comporte aucune 

application (il s’agit uniquement d’une présentation de l’interface du logiciel).  

1. Présentation du logiciel MapInfo 

Le logiciel qui sera utilisé dans ce TP est MapInfo Professionnel (Version 8.0). Ce logiciel 

présente beaucoup d’avantages parmi lesquels : 

- Son interface simple et conviviale 

- Le langage de programmation utilisé par ce logiciel est Map Basic qui permet d’ajouter de 

nouvelles applications répondant aux exigences de tous projets). 

- Les outils puissants qu’il offre pour la gestion et le traitement des données. 

- La possibilité d’exportation et d’importation vers et de logiciel de bureautiques standards. 

- C’est un puissant outil cartographique qui permet d’afficher, de manipuler et d'analyser tout 

type de données, géographiques ou alphanumériques.  

- Opérations de superposition : superposition de couches thématiques (Fig. 02) ; 

- Il permet la réalisation de traitements statistiques ; 

- Il a la possibilité d’échanger des données avec les autres SIG (ArcGis, ArcInfo, etc.) et les 

logiciels de (CAO/DAO), tel que « AUTO CAD » ; 

- Disponibilité d’une bibliothèque de symboles cartographiques, de trames et légendes 

modifiables de façon interactive ; 

- Son langage de requête qui permet de mixer les entrées graphiques et non graphiques et 

d’interroger les cartes. 

Le logiciel MapInfo Professional est un Système d'information géographique (SIG) créé 

durant les années 1980 aux États-Unis. C'est un logiciel qui permet de réaliser des cartes en 

format numérique. MapInfo est conçu autour d'un moteur d'édition de cartes qui permet la 

superposition de couches numériques. Il permet de représenter à l'aide d'un système de 

couches des informations géo-localisées sous format vectoriel et raster. 
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2. Présentation de l’interface MapInfo 

Quand on ouvre la fenêtre du logiciel MapInfo, une fenêtre, tel que présenté dans la figure 1, 

apparait à l’écran. Cette dernière permet d’ouvrir le travail dernièrement ouvert sur MapInfo 

(dernière session ou dernier document) ou d’ouvrir un autre travail (Table ou document). Si 

on clique sur le bouton annulé MapInfo est ouvert sans charger aucun travail précédemment 

préparé, l’écran reste vide comme montré sur la figure 2. On visualise alors sur l’écran les 

composants principaux de la fenêtre u logiciel qui sont : la barre des titres, la barre des menus 

principaux (menus déroulant), la barre des outils standards, la barre d’état et trois menus 

flottants nommés « Général », « Dessin » et « Sync Windows ». 

 

Figure 1 : Fenêtre de base de MapInfo. 
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Figure 2 : Présentation des composants de l’interface MapInfo. 

- Le menu principal est composé de plusieurs menus déroulants. Dans ce menu on 

retrouve des menus permanents qui sont présents quelques soit le travail qu’on 

effectue (il s’agit de : Fichier, Edition, Outils, Objet, Sélection, Table, Option, Fenêtre 

et Aide) et de menus qui s’active lorsque les taches leur correspondant sont actives à 

l’écran, il s’agit des menus : Carte, Légende, Mise en page, carte graphique. C’est 

deniers s’insèrent entre les menus Option et Fenêtre (Figure 3). 

 

 

Figure 3 : Le menu principal (les menus déroulants). 

Le menu principal est composé de plusieurs menus déroulants qui sont comme suit : 

Le menu Fichier : Ce menu permet de gérer les fichiers que vous créez ou ouverts sous 

MapInfo. On retrouve ce type de menus dans tous les logiciels Windows (Word, Excel,…). Il 

comprend des fonctionnalités d’ouverture, d’enregistrement, d’exportation, d’impression et de 

fermeture des fichiers. 

Le menu Edition : de la même manière que pour tous les logiciels Windows, ce menu vous 

donne la possibilité d'annuler la dernière action, de copier, couper, coller ou effacer le ou les 

objets. Par ailleurs, pour exécuter une de ces fonctionnalité il faut les sélectionner l’objet à 

l’avance. Un outil spécifique à MapInfo a été également rajouté, il s’agit des commandes 

Menu principal 

Barre des titres 

Barre des outils standards 

Synchronisation 

Windows 

Menu général 
Menu de dessin  

Barre d’état 

Fenêtre dépendante de la tâche 

effectuée 
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Modifier objets et Nouvelle ligne qui servent à modifier des objets (communes, routes, etc.) 

représentés à l'écran (actif seulement si la couche de dessin les comportant est modifiable). 

Ainsi que la commande Informations qui sert à afficher les caractéristiques (position, taille et 

forme) d'un objet sélectionné. 

Le menu Outils : Ce menu permet d'accéder aux outils offerts par MapInfo, tel que les 

traducteurs de format pour les fichiers provenant d'autres logiciels (ArcView, Arclnfo, etc.), 

les traducteurs universels des unités, l’exécution d’outils préexistants (tel que l’échelle, 

l’indicateur du nord …) 

Le menu Objets : Ce menu contient des fonctionnalités permettant de manipuler les objets, tel 

que : les assembler, les transformer, modifier leur forme, créer des surfaces, les fusionner, ... 

Le menu Sélection : Ce menu représente comprend des outils de sélection et notamment les 

commandes de sélection SQL qui permet d’exécuter des requêtes spatial et thématiques sous 

SIG et permet ainsi de faire apparaitre, à l’aide d’expressions mathématiques, des 

caractéristiques nécessaires à la prise de décision. 

Le menu Table : Les commandes de ce menu permettent de gérer les tables en exécutant des 

opérations graphiques, de calage ou modification du calage des images Raster et statistiques 

ainsi que l’association de données attributaires aux objets. Ce menu comprend également les 

deux commandes Importer et Exporter permettent de gérer des données (numériques ou 

graphiques) provenant d'autres sources ou qui doivent être converties vers d'autres logiciels, 

tels que : AutoCAD ou des bases de données dBASE. 

Le menu Options : Ce menu est composé de plusieurs blocs : 

Bloc "Style" qui permet de contrôler et modifier la forme des différents objets graphiques 

(lignes, polygones, symboles, texte) dans les couches modifiables. 

Bloc "Affichage" qui gère l’affichage à l'écran des différents outils de travail (barres d'outils, 

légendes,...) 

Bloc "Palette"  qui comprend la commande Palette qui permet d’afficher les couleurs 

disponibles pour les différentes analyses et affichage ainsi que la commande Préférences 

permettant de personnaliser certains paramètres. 

Le menu Fenêtre : Il permet de parcourir les différentes tables ouvertes et d'en afficher 

respectivement les fenêtres carte ou les fenêtres de données (le tableau correspondant) ainsi 

que de créer des nouveaux graphiques en partant des données du tableau et de gérer la mise en 

page de votre travail en vue d'une impression. La commande Sectorisation permet de 

regrouper des objets suivant certaines caractéristiques et d'obtenir ainsi une nouvelle couche 

avec des nouveaux objets géographiques. 
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Le menu Aide : Ce menu permet d’accéder au manuel d’utilisation du logiciel comprenant 

des conseils pour l’utilisation correcte des commandes du logiciel. 

- Le menu général : Ce menu est illustré dans la figure 4. 

 

Figure 4 : Présentation du menu Général. 

- Le menu de Dessin : Ce menu est présenté dans la figure 5. 

 

Figure 5 : Présentation du menu de Dessin. 

 

 

 

Sélection par rectangle 

Sélection par forme libre 

Tout sélectionner 

Sélectionner dans un graphique 

Zoom arrière 

Déplacement  

Hotlink 

Dupliquer la fenêtre carte 

Distance  

Afficher /Cacher Statistiques 

Affecter sélection  

 Définir pochoir  

 

Sélection  

Sélection par distance 

Sélection par polygone 

Inverser la sélection  

Zoom avant  

Zoom 

Informations 

Étiquette 

Contrôle des couches 

Afficher/Cacher légende 

Définir secteur cible 

Activer/Cacher pochoir 

 

Ligne  

Arc de cercle 

Ellipse  

Rectangle arrondi 

Cadre 

Ajouter des nœuds  

Style de ligne 

Style de texte 

Symbole 

Polyligne 

Polygone 

Rectangle 

Texte 

Modifier objets 

Style de symbole 

Style de polygone 
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3. Composant d’une table MaInfo 

Une table MapInfo est constituée de plusieurs fichiers liés entre eux et ne peut s’ouvrir si l’un 

de ces fichiers est supprimé ou déplacé. Il s’agit : 

 .TAB : fichier de description de la table MapInfo. Il s’agit du fichier qu’on exécute 

pour ouvrir la table sous MapInfo. 

 .DAT, .XLS, .DBT, .MDB : qui représentent les fichiers contenant la base de données 

associée à la table (données tabulaires du SIG). 

 .MAP : fichier contenant les informations géométriques des objets cartographiques. 

 .ID : fichier permettant d’effectuer la liaison entre les enregistrements de la base de 

données et les objets dessinés dans la carte. 

 .IND : fichier permettant l’index de la base de données. 

 .WOR : Il s’agit de l’extension associé aux documents MapInfo. Il ne contient pas les 

données (qui sont dans les tables), mais répertorie l’ensemble des tables nécessaires et 

gère leur utilisation. 
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TP02 : Calage et affichage d’une carte (Image Raster) 

 

L’objectif de ce TP est de montrer aux étudiants comment ouvrir et caler une image sous le 

logiciel MapInfo en respectant le système de projection selon lequel elle a été réalisée. 

1. Les commandes nécessaires pour le calage des cartes  

Pour caler une carte il faut agir comme suit : 

a. Ouvrir une image Raster sous le logiciel MapInfo :  

Pour ouvrir un fichier de type Image Raster sous le logiciel MapInfo, il faut exécuter les 

commandes suivantes : Fichier > Ouvrir Table. Une boite de dialogue s’affiche sur l’écran 

(Figure 1), on choisit le type de fichier dans le menu déroulant (Fichier de Type > Raster 

Image : *.bil ;*.tif ;*.grc ;*.bmp ;*.gif ;*.tga ;*.jpg ;*.pcx ;….) et on ouvre la table (Figure 

2). 

 

Figure 1 : Ouverture d’une image. 
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Figure 2 : choix du type de fichier « image Raster sous MapInfo ».  

Une fois l’image raster ouverte on a le choix entre afficher l’image sans la calée ou effectué le 

calage d’abord (Figure 3). 

 

Figure 3 : calage ou affichage d’une image raster. 

b. Définition du type de projection (à l’aide du bouton projection)  

Le choix du type de projection est très important pour assurer un bon calage des cartes. Le 

système de projection Universal Transverse Mercator (UTM), créé pour éviter les problèmes 

de convergence entre les degrés et le mètre, est utilisé à titre d’exemple dans ce  TP. Ce 

système se base sur une décomposition du globe terrestre en soixante (60) fuseaux de 6° 

chacun (numérotés de 01 à 60) et vingt (20) bandes de 8° chacune (les bandes sont identifiées 

par des lettres. L’Algérie est localisée entre les fuseaux 29 et 32 et dans les bandes Q, R, S 

(voir le chapitre 2). L’exemple affiché dans les figures 4 et 5 montre le calage d’une image 
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aérienne de la ville d’Ain El Hammam (Wilaya de Tizi-Ouzou) qui est localisée au nord de 

l’Algérie. Cette ville se trouve comme le montre la figure 4 dans le fuseau 31 de l’hémisphère 

nord. Le type de projection est défini sous le logiciel MapInfo en suivant les commandes 

suivantes : Table > Image Raster > Modifier Calage ou bien en acceptant de caler la carte 

immédiatement après son ouverture (Figure 3). Une fenêtre s’affiche sur l’écran (Figure 4). Il 

faut alors cliquer sur le bouton Unité et choisir l’unité adéquate (degrés ou mètres). Une fois 

les unités définies, il faut cliquer sur le bouton Projection. Une boite de dialogue s’affiche sur 

l’écran (Figure 5) ; on choisit : 

- La catégorie de la projection : Universal Transverse Mercator (WGS84). 

- La projection: UTM Zone 31, Northern Hemisphere (WGS84).    

 

 

 

 

 

 

 

 

 

 

Figure 4 : Désignation des unités sous MapInfo. 

 

 

 

 

 

 

 

 

Figure 5 : Désignation du système de projection. 
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c. Indication des coordonnées des points de calage. 

Après la définition des unités et du système de projection, il faut introduire les coordonnées 

des points de calage. Pour ce faire, il faut suivre les étapes suivantes : 

- Supprimer les points de calage donnés par défaut ; 

- Cliquer au niveau du point de calage sur la carte en utilisant le curseur ; 

- Entrer les coordonnées X et Y du point dans la fenêtre calage (Figure 6) ; 

Il faut refaire la même procédure jusqu’à la désignation de tous les points de calage. Une fois 

tous ces points indiqués, on clique sur le bouton OK et on enregistre la table.    

 

 

 

 

 

 

 

 

 

 

Figure 6 : Procédure d’indication des points de calage. 

Après avoir effectué toutes les étapes nécessaires pour le calage de l’image, un fichier qui 

porte le même nom que l’image avec une extension « .tab » est créé dans le répertoire où se 

trouve l’image source. C’est ce fichier « *.tab » qui conserve les paramètres de calage de 

l’image. Il faut noter que pour pouvoir afficher l’image raster calée on a besoin du fichier 

image source + le fichier « .tab » correspondant. En cas d’absence de l’un de ces deux fichiers 

la table ne peut pas s’ouvrir sous le logiciel MapInfo. 
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Figure 7 : Aperçu d’une image calée (carte géologique d’Alger). 
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TP03: Création de Couches vectorielles et modification de la 

géométrie des objets 

 

L’objectif de ce TP est d’apprendre aux étudiant comment créer une couche vectorielle sous 

MapInfo.  

1. Création d’une nouvelle table 

Pour créer une nouvelle table (couche de dessin), il faut exécuter les commandes : « Fichier / 

Nouvelle Table » de la barre du menu principal (figure 1). 

 

Figure 1 : Commandes permettant la création d’une nouvelle table. 

En exécutant ces commandes, apparait une boite de dialogue (Figure 2) qui permet de choisir 

le type de table qu’on veut créer (Table de données, table carte ou une fenêtre associée à la 

carte active). On appui sur le bouton créer et une nouvelle boite de dialogue s’affiche à 

l’écran. Cette boite de dialogue permet de gérer la structure de la table (associer des champs 

de données à la table) et la projection selon laquelle elle sera effectuée.  
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Figure 2 : Boite de dialogue pour la création d’une nouvelle table (couche). 

 

Figure 3 : Boite de dialogue permettant la gestion de la structure de la table. 

Avant de créer les différents champs de la table, on commence d’abord par choisir le système 

de projection à l’aide du bouton projection (Figure 3). Ensuite, on procède à la création des 

champs et leurs caractéristiques.  

Exemple : Nous allons créer une table graphique de routes (routes.Tab) qui doit comporter 

(figure 4) : 

- L’identifiant de la route (ID) de type caractère (par exemple RN12). 

- Catégorie de la route (R_type) de type caractère (route nationale, chemin de 

wilaya,…) 

- Le nombre de voies (Nb_V), de type entier. 

- La largeur de la voie (Lv), de type flottant. 

- Le gabarit (GB), de type flottant. 
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- Date de réhabilitation (date_reha), type date. 

On peut changer la position des champs dans la base de données à l’aide des boutons Monter 

et Descendre de la figure 3. En fin on clique sur le bouton créer et une nouvelle table est 

ouverte. Cependant, cette table est vide. 

 

Figure 3 : Exemple de structure d’une table graphique 

2. Digitalisation (Vectorialisation) de la couche créée 

a. Création d’objets  

Une fois la couche de dessin (table graphique) est créée et enregistrée (dans ce cas sous le 

nom : routes.tab), on peut procéder à la digitalisation des routes à partir d’un support 

topographique. Dans ce cas nous allons utiliser la carte topographique d’Alger calée lors du 

TP02.  

La digitalisation d’une couche consiste à créer des objets (de type points, lignes ou polygones) 

modifiables. Par ailleurs, il est recommandé de créer des objets de type homogène dans une 

même table graphique. Par exemple : dans la table « routes.tab » on va représenter des 

éléments linéaires (polylines) uniquement pour indiquer des objets de type Points permettant 

de repérer la présence de ponts, trémies, … il est recommander de créer une autre table 

graphique.  

Afin de créer les objets dans une table graphique, on exploiter le menu dessin (figure 4). 

Chacun des composants de ce menu permet la création d’un type d’objets donné. Quand le 

bouton punaise ( ) est séléctionné on peut dessiner des objets de type Point. Le bouton 

avecune ligne brisée ( ) permet e créer des polylines. Le bouton polygone rempli en vert (

) sert à numériser des objets surfaciques. Le bouton (A) permet d’insérer des textes dans la 

table. Les mêmes boutons avec des points d’interrogation permettent de modifier le style des 
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objets. Les boutons ( ) permettent respectivement de modifier les objets et d’ajouter 

des points à l’objet de type polyline ou polygone. 

 

Figure 4 : Présentation du menu de dessin. 

La géométrie d’un objet peut être modifiée uniquement en mode fusion. Pour passer en mode 

FUSION activée ou désactivée il suffit de cliquer sur la touche « F » du clavier. Quand le 

mode Fusion est actif l’acronyme « FUS » est indiqué en bas de fenêtre du logiciel MapInfo 

comme indiqué sur la figure 5. Dans ce mode dès que le curseur traverse un point 

intermédiaire il change de forme (voire la figure 5). Dans ce cas, le nouveau point créé aura 

les mêmes coordonnées que le point capturé par le curseur. 

La modification de la position d’un point d’un polygone ou d’une polyline se fait en utilisant 

le bouton (  ) du menu dessin. Quand ce bouton est actif les points intermédiaires 

composant un objet apparaissent et deviennent modifiables. Il suffit alors de cliquer avec le 

curseur sur le point qu’on veut modifier et le faire déplacer. Si nécessaire, on peut également 

rajouter d’autres points à l’objet en activant le bouton ( ) du menu dessin et cliquant avecle 

curseur à l’endroit où on veut créer un point intermédiaire. 

Outils permettant la 

création d’objets de type : 

points, lignes, polygones, 

textes et cadres 

Outils de modification du 

style par défaut de chacun 

des objets 

Outils pour modification 

des objets graphiques et 

ajouts de points 
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Figure 5 : Passage en mode Fusion 

b. Modification des objets 

La géométrie d’un objet ne peut être modifiée que dans une table modifiable. Alors on doit 

rendre la table pour laquelle on veut modifier la géométrie des objets modifiant on procédant 

comme suit : Cliquer sur le bouton contrôle des couches du menu général une boite de 

dialogue s’affiche à l’écran, sélectionner le stylet (Figure 5)  

-  

 

 

 

 

 

 

 

 

 

 

Figure 5 : Présentation des outils de gestion d’une table. 

Après avoir rendu la table modifiable et sélectable, on peut modifier la géométrie des objets, 

créer des surfaces, vérifier les régions, … comme le montre la figure 6. 

 

 

 

Rendre la table 

modifiable 

(a) La barre du menu général 

(b) La fenêtre du contrôle des couches de dessin 

Contrôler la 

visibilité de la table 

Rendre la table 

sélectable  
Ajouter une 

étiquette à la table 
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Figure 6 : Les modifications qu’on peut apporter à un objet graphique. 
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TP04: Importation et Semé de données Topographiques  

 

L’objectif de ce TP consiste à permettre aux étudiants de découvrir la méthode d’importation 

de tables de données et la création de points sous  MapInfo 

1. Importation d’une base de données sous MapInfo 

Afin d’importer une base de données réalisée sous Excel, exécuter les commandes suivantes : 

Fichier > Ouvrir table > Choisir le type de fichier (Microsoft Excel) > Ouvrir le fichier 

(figure 1) 

 

Figure 1 : Ouverture d’une base de données sous MapInfo. 

Une fois le fichier le type de fichier « Microsoft Excel » sélectionné on choisit le fichier à 

ouvrir (exemple : « deplacement T8T9 ») et on clique sur le bouton « OUVRIR ». Une 

nouvelle boite de dialogue s’affiche alors sur l’écran. Cette boite de dialogue (Figure2) nous 

permet de choisir la feuille du classeur Excel qui contient les données. Si la première ligne de 

cette feuille comporte des titres on doit cocher le petit rectangle blanc qui apparait en bas à 

gauche en cliquant à l’intérieur de ce dernier avec le bouton gauche de la souris. 
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Figure 2 : Boite de dialogue comportant des informations sur la base de données. 

Une base de données qui comporte les mêmes champs que ceux définis sur le fichier Excel est 

alors créer sous MapInfo (Figure 3). Cette dernière garde le même nom que la base initiale (le 

même nom que le Fichier Excel). 

 

Figure 3 : Extrait de la base de données créée. 

Remarque : Deux nouveaux fichiers seront créés dans le dossier qui comporte le fichier Excel 

importé. Ces deux fichiers et le fichier Excel sont nécessaires pour l’ouverture de la table de 

données. 

1. La réalisation d’un semi de données topographiques 

La réalisation d’un semi de points topographiques consiste à créer des objets graphiques (type 

points) géo-référenciés c’est-à-dire des objets graphiques occupant des coordonnées connues 

dans l’espace.  La réalisation du semi de points nécessite la réalisation d’une base de données 

comportant les cordonnées des points organisée sous un format accepté par le logiciel 

MapInfo. Ainsi, il faut importer un fichier préparé sur Excel comportant en moyenne 04 

colonnes (Identifiant du point, position en X, position Y et l’altitude Z). Le fichier peut 

Menu déroulant 

permettant le choix 

de la feuille Excel à 

ouvrir 

Rectangle à cocher 

si la première ligne 

de la feuille 

comporte des titres 
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également comporter des champs (colonnes) réservées à des informations nécessaires pour 

l’analyse du phénomène étudié (Tableau 1).  

Tableau 1 : Aperçu du format de la base comportant les points topographiques 

N° X[m] Y[m] Z[m] Observation 

1 616963,571 4048152,66 962,93 A1 

2 616949,667 4048130,41 952,622 A2 

3 616940,571 4048115,41 945,418 A3 

4 616933,724 4048103,44 944,907 A4 

La réalisation du semi de points topographiques consiste à ouvrir le fichier de données. Un 

fichier attributaire est alors créé sous MapInfo et la table de données est affichée. Puis 

exécuter les commandes suivante afin de créer les objets : Table > Créer points du menu 

principal (Figure 4) 

 

Figure 4 : Commandes à exécuter pour créer des points  

Une boite de dialogue qui permet l’identification des coordonnées X et Y, le type de symbole 

et la nature de la projection à utiliser s’affiche à l’écran (Figure 5). Enfin, une fois tous les 

champs remplis, il faut cliquer sur OK et afficher le semi des points en exécutant les 

commandes Fenêtre > Carte du menu principal (Figure 6). 
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Figure 5 : Boite de dialogue permettant la création des points topographiques 

 

Figure 6 : commandes à exécuter pour afficher les points. 
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TP05: Jointure de bases de données. 

 

Le but de ce TP est de permettre aux étudiant comment réaliser une jointure d’une base de 

données à une carte composée d’objets géo-référenciés à  partir d’un  champ  commun. 

L’association d’une base de données aux données spatiales permet d’effectuer des  analyses  

sur les données importées. 

La procédure suivie pour réaliser une jointure de bases de données 

Elle consiste à insérer des données organisées sous forme de champs à une carte vectorielle 

existante (une carte dessinée ou des points semés). Pour ce faire, il faut suivre les étapes 

suivantes : 

- Importer une base de données Excel sous MapInfo (voire le paragraphe 1 du TP04). 

- Rendre la table pour laquelle on veut insérer des données modifiable en suivant les 

étapes de la figure 1. 

 

 

 

 

 

 

 

 

 

 

Figure 1 : Présentation des commandes nécessaires pour rendre une table modifiable. 

- Réaliser une base de données sous le logiciel MapInfoen prossédant comme suit : 

Créer les champs de données sous MapInfo en exécutant les commandes suivantes : 

Table>Gestion des Tables>Modifier structure du menu principal (Figure 2). Une 

boite de dialogue (Figure 3) permettant d’ajouter ou de supprimer des champs 

s’affiche. Il faut créer les champs nécessaires en précisant le format de l’information 

(caractère, flottant, date, etc.). Le format du champ choisi pour la base de données 

 

 

 

Modifiable 

(b) La barre du menu général 

(b) La fenêtre du contrôle des couches de dessin 
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MapInfo doit correspondre à celui de la base Excel sinon la jointure ne sera pas 

possible. 

 

Figure 2 : Les commandes à exécuter pour créer une base de données associée à une table 

graphique. 

 

Figure 3 : Création ou modification d’une base de données sous le logiciel MapInfo.  

 

- Effectuer la jointure entre la table de données choisi (créé à partir du fichier Excel 

importé) et la table vectorielle qu’on veut mettre à jours en exécutant es commandes : 

Table>Mettre à jour colonne. Il faut ensuite choisir la table à mettre à jour, la table où 

prendre les valeurs, la colonne à mettre à jour et la liaison (figure 4). 
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Figure 4 : Mise à jour de la base de données. 
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TP06: Extraction de données (surfaces, coordonnées, 

distances) 

 

L’objectif de ce TP est de montrer aux étudiants comment extraire des informations des objets 

dessinés dans une table graphique et renseigner une nouvelle colonne (champ) de la base de 

donné de cette table. Les données tirées peuvent être de plusieurs types. Généralement, il 

s’agit de coordonnées d’éléments points, surface ou périmètre pour les éléments polygone et 

longueur pour les éléments ligne. 

1. Extraction de coordonnées 

Le logiciel MapInfo nous donne la possibilité d’extraire les coordonnée des points 

(coordonnées en X, Y ou en Longitude-Latitude)  et ainsi remplir les champs réservés à ce 

type d’informations en exécutant les commandes suivante du menu principal (Figures) : 

Outils => Gestionnaire des outils => Coordinate Extractor => OK 

  

Figure 1 : commandes à exécuter pour extraire des coordonnées 1ère étape. 

Ensuite, on exécute les commandes (Figure 2): Outils => Extracteur de Coordonnées => 

Extraire les Coordonnées qui est rajouté au menu Outils après l’exécution des commandes 

précédentes (commandes de la figure 1). Une boite de dialogue (Figure 3) s’affiche alors à 

l’écran. Cette dernière permet de choisir la table à partir de laquelle on va extraire les 

données, créé de nouvelles colonnes, les colonnes à remplir et la projection, etc. 
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Figure 2 : Commandes à exécuter pour extraire les coordonnées 2ème étape. 

 

Figure 3 : Extraction de coordonnées et création de nouvelles colonnes. 

En cliquant sur le bouton « OK » une table de données s’affiche à l’écran. Cette table contient 

les champs coordonnées X et Y remplis (Figure 4). 
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Figure 4 : La table de données créée. 

Pour éliminer les lignes grises en plus de la table de données, on exécute les commandes : 

Table => Gestion de table=> Compacter table du menu principal.  

2. Extraction des données géométriques (surface, longueur,…) 

Le logiciel MapInfo permet de remplir deschamps relatifs à la géométrie des objets 

graphiques en exécutants les commandes : Table => Mettre à jour colonne du menu principal 

(Figure 5). 

 

Figure 5 : Commandes nécessaires pour extraire des données géométriques. 

Une boite de dialogue, permettant de choisir la table à mettre à jour, la table d’où les données 

seront extraites, la colonne à mettre à jour et l’expression qui sera utilisée, est alors affichée 

(Figure 6). L’expression à utiliser sera choisi en fonction des données géométriques 

recherchées. Par exemple, dans le cas présenté sur la figure 6, on a pris la colonne 

« Surface », l’opérateur « égalité » et la fonction « Area (qui veut dire surface en langue 

anglaise) » donc on obtient l’expression mathématique suivante : surface=Area(obj, ‟sq m”). 

‟sq m” indique l’unité dans laquelle la surface sera calculée, dans ce cas il s’agit du m². 
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Figure 6 : Exemple d’extraction de données géométriques.  
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TP07: Superposition de cartes de projections différentes 

 

L’une des fonctionnalités principales des logiciels de SIG est la possibilité de superposer des 

tables (cartes) de différentes nature et effectuées selon différents systèmes de projection. 

L’objectif de ce TP est de montrer aux étudiants la procédure à suivre pour superposer 

différents types de tables.  

1. Ouverture de plusieurs tables sous un même espace (superposition des cartes)  

Afin d’ouvrir plusieurs tables sous un même espace, il suffit de les rajoutées à la fenêtre 

courante en exécutant les commandes : Fichier => Ouvrir du menu principal, puis choisir 

l’option rajouter à la fenêtre carte courantes dans le menu déroulant « visualisation » comme 

montré sur la figure 1. 

 

Figure 1 : Procédure suivie pour l’ouverture de plusieurs tables sous un même espace. 

La gestion des différentes tables se fait en exploitant le bouton Contrôle des couches du menu 

général «  ». En appuyant sur ce bouton, une boite de dialogue permettant la gestion des 

couches s’affiche à l’écran (Figure 2). Dans cette fenêtre on peut changer l’ordre d’affichage 
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des couches en utilisant les boutons « monter » et « descendre » du bloc « Réorganiser ». On 

peut également enlever ou ajouter des couches à la fenêtre d’affichage en utilisant les boutons 

du bloc « couches » ainsi que gérer la visibilité des couches, l’affichage des étiquettes, etc. 

 

Figure 2 : le contrôle de l’affichage des tables. 

2. Superposition de cartes réalisée selon des systèmes de projection différents sous 

MapInfo 

La connaissance du système de projection selon lequel a été effectuée une carte est très 

importante avant de procéder à une superposition de celle-ci avec d’autres cartes. Ceci évite 

les erreurs de calcul et d’analyse spatiales. Sinon on peut uniquement calculer des distances. 

Le logiciel MapInfo est doté d’un système permettant de changer le système de projection des 

cartes afin de garder un système de projection homogène pour toutes les tables composant un 

projet donné. Par ailleurs, il faut d’abord connaitre les systèmes de projection selon lesquels 

ont été calées ou digitalisées les différentes tables qu’on désire superposer. Pour ce faire, on 

exécute les commandes suivantes : Carte => Options. Une boite de dialogue s’affiche à 

l’écran. On clique sur le bouton projection pour vérifier la projection de la carte (Figure 3). 
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Figure 3 : Vérification du système de projection d’une carte. 

Pour changer le système de projection d’une table (couche), il suffit d’exécuter les 

commandes permettant d’enregistrer une table sous un nouveau nom : Fichier=> Enregistrer 

table sous. Dans la boite de dialogue qui s’affiche, on clique sur le bouton projection et on 

choisit un nouveau système de projection pour la table et enfin on enregistre la table sous un 

autre nom (Figure 4).  

       

Figure 4 : Modification du système de projection d’une table. 

Une fois les systèmes de projection de toutes les cartes homogénéisés, on peut les superposé 

et effectuer des analyses spatiales. 
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TP08: Requête et commande SQL 

 

L’objectif de ce TP est de permettre aux étudiants d’utiliser les requêtes SQL et de 

comprendre le langage qu’elles utilisent. Donc, leur permettre de se familiariser avec cet outil 

puissant pour la gestion des données et la prise de décisions. 

En effet, l’une des propriétés principales et des points forts des SIG réside dans leur capacité 

d’exploiter les données tant dans le mode attributaire (tableau) que dans le mode géométrique 

(carte). La maîtrise des outils d’interrogation des données est essentiel pour extraire des 

informations nécessaires à la prise décisions sur de l’information. Le logiciel étudié 

(MapInfo) base ce type de requêtes sur le langage SQL (Structured Query Language). Ce 

langage est répandu dans les logiciels de gestion des bases de données (Les systèmes 

d’Information « SI ») et a été incorporé sous le logiciel MapInfo vu sa large utilisation et son 

efficacité dans la gestion des données. Cependant, la particularité des SIG, qui permettent de 

gérer simultanément des données graphiques et attributaires, rend ce langage encore plus 

puissant car il peut également tenir compte des caractéristiques de l’objet, directement sur le 

territoire. 

1. Définition de la requête SQL 

Ainsi, une requête SQL est une opération d’interrogation réalisée sur une partie d’une base de 

données associée à une adresse géographique. MapInfo simplifie le recours aux requêtes SQL 

en proposant des interfaces graphiques assez conviviales pour interroger la base de données 

géographiques. Une requête SQL produit une table qui va contenir la/ou les réponses, à la 

question posée. Il est donc possible de relier les requêtes SQL entre elles pour produire une 

analyse plus complexe. 

Les questions posées aux bases de données SIG peuvent porter aussi bien sur les données 

attributaire que géographique des objets. Il est aussi possible d’interroger une base sur le plan 

sémiologique. 

Dans MapInfo, les connections SQL sont définies à partir d’une instruction SQL de type : 

SELECT ….. FROM ….WHERE…... pour laquelle les résultats sont exprimés sous forme 

d’une table MapInfo temporaire (sélection des données). 

2. Procédure d’utilisation des requêtes SQL sous MapInfo 

La procédure générale d'utilisation de la sélection SQL sous le logiciel MapInfo est expliquée 

dans la figure 1. Elle consiste à l’exécution des étapes suivantes : 

1. Ouvrir la table sur laquelle on veut effectuer une requête SQL (table source) ; 
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2.  exécuter les commandes : Sélection  =>  Sélection  SQL du menu principal.  Renseigner 

les différentes zones  de  la  boîte  de dialogue « Sélection SQL » qui s’affiche à l’écran selon 

les besoin de l’utilisateur (la question qu’on veut poser) ; 

Quand la requête SQL est appliquée sur une seule colonne d’une table donnée, dans le bloc 

« Colonnes » peut indiquer l’identifiant de la colonne sur laquelle on veut effectuer les 

opérations de sélection. Cependant, dans le cas où la requête nécessite plusieurs colonnes à la 

fois, soit on mit une étoile (Figure 3) ou bien on indique toutes les colonnes séparées avec par 

des virgules (voir Figure 3). De même, si la requête nécessites de faire intervenir plusieurs 

tables, on doit indiquer toutes les tables nécessaires dans le bloc « Tables » séparées par une 

virgule. 

En exécutant ces commandes, le logiciel MapInfo extrait les données de la table source et 

stocke les résultats de la sélection dans une table temporaire particulière, appelée « table de 

résultats ». Cette table de résultats s’affiche par défaut à l’écran en cliquant sur « OK ». Elle 

contient uniquement les lignes et colonnes correspondant au critère étudié (Figure 2). 

Le choix des critères d’interrogation est réalisé en replissant les cases réservées aux différents 

éléments composant la requête qu’on veut lancer. La liste déroulante « Colonne » permet 

d’accéder aux noms des champs de la table et choisir le champ correspondant à la requête. La 

liste déroulante « Opérateurs » permet de choisir les opérateurs mathématiques ou logiques 

qui peuvent être appliqués à la colonne choisie (« = », « > », « >= », « and »…) et la liste 

déroulante « Fonctions » permet de choisir des fonctions qui peuvent être appliquées aux 

champs choisis. Cependant, d’autres fonctions peuvent être saisies manuellement (exemple : 

between, before,…).  La touche «Vérifier » nous permet de contrôler la syntaxe de 

l’expression saisie. Le bouton «OK » transmet la formule choisie dans la rubrique « Critères » 

de la fenêtre « Sélection » et permet d’afficher les résultats de la requête. Dans cette fenêtre, il 

est également possible, de sauvegarder les requêtes les plus utilisée grâce au bouton « Sauver 

modèle » (Figure 1). 

Exemple 1 : Application sur une seule colonne  

Dans cet exemple nous allons exécuter une requête SQL permettant de sélectionner les objets 

pour lesquels l’Indice (ID) est supérieur ou égal à 3. Pour ce faire, nous avons choisi la 

colonne concernée par la sélection, la table qui sera objet de la requête et tapé dans la case 

réservée au critère l’expression suivante : ID >= 3 
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Figure 1 : Exemple de requête SQL sur une seule colonne. 

 

 

Figure 2 : résultat de la requête SQL lancée. 

Exemple 2 : Application sur des deux colonnes (champs) à la fois 

Dans cet exemple nous allons exécuter une requête SQL qui fait intervenir deux colonnes à la 

fois pour sélectionner les routes de type Route Nationale (RN) réabilité durnt la période 

comprise entre 01/01/2010 et le 01/01/2017. Pour ce faire, on choisit les colonnes concernées 

séparée par des virgules ou on tape « * » dans la case « Colonnes », on choisi la table qui sera 

objet de la requête et on tape dans la case réservée au critère l’expression suivante : date8reha 

between ‘’01/01/2010’’ and ‘’01/01/2017’’ and R_type = ‘’RN’’. 
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Figure 3 : Requête SQL sur deux colonnes à la fois. 

 

Figure 4 : Résultats obtenus en effectuant une requête sur deux colonnes. 

MapInfo sélectionne automatiquement tous les éléments correspondant à la requête lancée 

dans la table graphique (voir exemple 1 et exemple 2). Ainsi, après la réalisation de la requête 

sélection SQL, il est possible d'effectuer des opérations sur l'ensemble des objets sélectionnés. 

Par exemple : appliquer une couleur différente en exécutant les commandes  « Affichage => 

Style polygones, polyligne ou point »en fonction du type d’éléments sélectionnés. On peut 

également  Couper et les Copier les objets dans leur ensemble (Figure 5). 
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Figure 5 : Modification du style des objets sélectionnés en exécutant la requête SQL. 

 

La commande «Sélection/Sélection…» permet également d’accéder à cette fonctionnalité. 

Cette commande permet d’afficher une boite de dialogue qui se développe de la manière 

suivante : 

Choix de la table cible parmi les tables ouvertes dans une liste déroulante, choix d’une 

expression pour le critère, saisie du nom de la table temporaires créée en exécutant la requête 

et le mode de tri des résultats (Figure 6). Pour effectuer une requête donnée, on saisit 

l’expression de  cette dernière à l’aide de la fenêtre expression. Sinon on peut sélectionner 

toute la table si en laissant la case réservée au critère vide (Figure 6). 

 

Figure 6 : Exemple d’exécution d’une requête en utilisant la sélection. 
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TP09: Mise en forme d'une carte et analyse thématique 

 

L’objectif de ce TP est de montrer aux étudiants les mises en forme qu’on peut appliquer à 

une carte graphiques ainsi que la procédure permettant la réalisation d’analyses thématiques 

sous le logiciel MapInfo. 

1. Mise en forme d’une carte 

La mise en forme d’une table graphique sous MapInfo comprend la mise en, la gestion et la 

modification du style des objets et du texte, l’affichage d’étiquettes, la gestion de 

l’affichage,… 

a. Changement du style des objets 

Le style des objets composant une table graphique peut être changé en procédant de deux 

manières différentes selon qu’on désire effectuer des modifications temporaires ou non  

Procédure 1 : Elle consiste à appliquer des modifications qui disparaissent à la fermeture de 

la table. Ce type de modifications ne peut pas être sauvegardé. Il s’agit uniquement d’une 

gestion de l’affichage. De plus, cette modification concerne toute la table et ne peut pas être 

appliquée à quelques éléments uniquement. 

Cette opération est effectuée en exécutant la touche gestion des couches «  » du menu 

général. Une fenêtre s’affiche à l’écran et on clique sur la touche « Affichage » alors une 

nouvelle boite de dialogue s’affiche (Figure 1). 

 

Figure 1 : Procédure suivie pour changer le style d’affichage des objets d’une table graphique 
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Procédure 2 : Cette procédure permet d’appliquer des modifications dans le style d’affichage 

de certains ou tous les objets composant une table graphique de façon permanente (possibilité 

d’enregistrer les nouvelles mises en forme des objets). Pour ce faire, Il suffit de rendre la carte 

modifiable en appuyant sur la touche «  » puis on coche la case rendre la couche 

modifiable «  » correspondante à la table qu’on désire modifier. Une fois la table est 

modifiable on exécute les touches qui permettent de modifier le style des objets qui se 

trouvent en bas du menu dessin (Figure 2).  

 

Figure 2 : Outils de modification du style des éléments 

b. Gestion du seuil d’affichage 

Afin d’éviter que la carte soit encombrée ou illisible, on peut affecter un seuil de zoom au-

delà duquel la couche ne va plus s’afficher. Pour effectuer cette opération, on exécute la 

commande contrôle des couche «  » du menu général, puis on clique sur la touche 

affichage. Dans la fenêtre qui s’affiche (Figure 3) on coche la case « utiliser les seuils de 

zoom » et on précise la fourchette de zoom dans laquelle la couche peut s’affichée. Une fois 

cette fourchette dépassée la couche devient invisible. 

Modifier le style des points 

Modifier le style des polygones 

Modifier le style des lignes 

Modifier le style du texte 
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Figure 3 : Insertion d’un seuil de zoom.  

c. Étiquetage d’une carte 

Pour afficher des étiquètes relatives à un champ d’une couche données (table), on exécute les 

commandes suivantes : Carte => contrôle des couches, cocher la case « étiquette ‘ ’ », 

cliquer sur « Étiquettes » pour choisir le format de l’étiquette.  

 

Figure 4 : Gestion des étiquettes. 

 

 

Option de visibilité des 

étiquettes (choix d’un 

seuil d’affichage) 

Modification du style 

du texte et des lignes de 

l’étiquette 
Gestion de la position de 

l’étiquette (on clique sur 

l’élément de position 

Point d’ancrage) 

Outils de gestion 

de l’affichage des 

étiquettes 

Choix du champ pour 

lequel les étiquettes 

seront affichées 



Université des Sciences et de la Technologie Houari Boumediene (USTHB)  
Cours de SIG                                                                                          

Dr. DJERBAL Lynda – Maitre de Conférences « B » 
Page 59 

 

 

2. Analyse thématique sous MapInfo 

La possibilité deréaliser des analyses thématiques (analyse spatiale des attribues) constitue 

l’une des propriétés principales des SIG. Sous MapInfo, ce type d’analyses se fait sur tous 

types de champs et tous types d’objets (lignes, points et polygones). Il suffit de choisir le type 

correspondant à l’analyse qu’on désire effectuer. Afin d’accéder à la fenêtre d’analyse 

thématique, on exécute les commandes suivantes : Carte => Analyse thématique du menu 

principal. Une boite de dialogue s’affiche à l’écran. Cette boite est répartit en 3 étapes. 

1. Dans la première étape, Mapinfo demande de choisir le type de carte thématique on 

désire concevoir (Figure 5). On a le choix entre plusieurs types de cartes thématiques 

fournies par défaut dans la base du logiciel MapInfo. 

2. Dans la seconde étape, on choisit la table et les variables qui vont être analysées 

(Figure 6). 

3. Dans dernière étape, on a la possibilité de modifier l'apparence de l’analyse 

thématique, en modifiant le choix des couleurs le nombre d’intervalles, les seuils, etc 

(Figure 7). 

 

Figure 5 : Exécution d’une analyse thématique étape 1. 
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Figure 5 : Exécution d’une analyse thématique étape 2. 

 

Figure 5 : Exécution d’une analyse thématique étape 3. 

Remarque : Pour sauvegarder l’analyse thématique réalisée, on exécute les commandes 

suivantes (il faut enregistrer le travail sous un document) : Fichier => enregistrer document 

sous du menu principal. 
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TP10: Mise en page et impression d'une carte 

 

Le but de ce TP est de montrer aux étudiants la procédure à suivre pour effectuer une mise en 

page et l’impression d’une carte issue d’une analyse avec les SIG. 

1. Insertion d’une légende  

Afin de créer la légende d’une carte on procède comme suit : Carte => Créer légende  

Une boite de dialogue s’affiche à l’écran (Figure 1) et on choisit les tables pour lesquelles on 

veut créer une légende et clique sur « suivant ». 

  

 

 

 

 

 

 

 

 

Figure 1 : Procédure de création d’une légende. 

 
Figure 2 : Exemple de légende. 
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2. Mise en page d’une carte  

Avant de de procéder à une mise en page d’une carte, il faut d’abord rendre la « couche de 

dessin » modifiable comme montrer sur la figure 1. La mise en page de la carte est activée en 

exécutant les commandes : Fenêtre => Mise en page du menu principal. Afin d’avoir une 

carte exploitable, on doit insérer le titre de la carte, l’échelle, la flèche indiquant le nord, la 

légende, etc (Figure 3). 

 

Figure 3 : Exemple de mise en page de carte. 

Remarque : En activant le mode « mise en page », on passe du référentiel global (le système 

de projection utilisé) à un référentiel local de la feuille de papier. Les unités de travail 

deviennent alors des centimètres. Il est donc nécessaire d’indiquer l’échelle de la carte. 

Quand on travaille dans la fenêtre Mise en page, on change de référentiel. On passe du 

système de projection à la feuille de papier. Dans ce cas l’unité de travail devient le 

centimètre. 
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Figure 4 : Déclaration de la couche de dessin modifiable. 

- Insertion de texte  

Pour insérer un texte dans la carte (titre, informations complémentaires, etc.), On commence 

par choisir le Style texte dans la barre de dessin puis on appui sur la Touche « A » pour 

insérer du texte à l’endroit voulu (Figure 5). 

 

Figure 5 : Insertion du texte dans une carte.  

- Insertion de la flèche indiquant le Nord 
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L’indication du Nord est nécessaire pour que la carte soit exploitable. Afin d’indiquer le Nord 

sur une mise en page de carte, on clique sur l’outil de dessin des points «  » du menu 

dessin puis on insère un point à l’endroit où on veut mettre l’indication du Nord. Une fois 

l’Objet pint inséré, on double clic sur celui-ci pour afficher le style « Symbole » et on choisit 

le symbole du Nord dans la bibliothèque des symboles (on choisit la catégorie MapInfo 

Arrows) puis on valide le choix comme le montre la figure 6.  

 

Figure 6 : Insertion de l’indication du Nord. 

- Insertion d’une échelle 

La représentation d’une portion de la surface de la terre sur une carte doit être accompagnée 

par l’indication de l’échelle dans laquelle elle est présentée, vu qu’elle ne peut pas garder les 

grandeurs réelles des objets. La mesure de cette réduction est exprimée par un rapport appelé 

« échelle de la carte ». Elle est définie comme étant le ratio de la distance sur carte et sur 

terrain. 

Une échelle peut être exprimée en utilisant différentes manières, tel que : 

 Fraction (1 : 50000 ou 1/ 50000) ; 

 Expression écrite (1 centimètre équivaut à 500 mètres) ; 

 Graphique. 

Pour afficher l’échelle d’une carte, on exécute les commandes suivantes (Figure 7) : Outils 

=> Exécuter => ScaleBar du menu principal. 
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Figure 7 : Ajout de l’outil de dessin d’échelle de la bibliothèque MapInfo. 

Une fois l’outil de dessin de l’échelle est exécuter, il est rajouté automatiquement au menu 

« Outils » du menu principal. Pour insérer l’échelle, on retourne une autre fois au menu 

« Outils ». Dans le menu déroulant, on clique sur « Échelle », on configure l’échelle puis on 

l’insère (Figure 8). 

  

 

 

 

 

Figure 8 : Configuration et dessin de l’échelle d’une carte 
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Une fois la configuration de la mise en page de la carte terminée, le travail doit être 

enregistrer sous un document (.wor) en exécutant les commandes : Fichier => Enregistrer 

document sous du menu principal.  

L’impression de la carte est réalisée en exécutant les commandes : Fichier => Imprimer du 

menu principal. 
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